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概要

Siemens TCP/IP Server Ethernet ドライバーとは

設定

このドライバーを使用するためにデバイスを構成する方法

データ型の説明

このドライバーでサポートされるデータ型

アドレスの説明

Siemens TCP/IP イーサネットデバイスでデータ位置のアドレスを指定する方法

イベントログメッセージ

ドライバーで生成されるメッセージ

概要

Siemens TCP/IP Server Ethernet ドライバーはSiemens TCP/IPサーバーデバイスがHMI、SCADA、Historian、
MES、ERPや多数のカスタムアプリケーションを含むクライアントアプリケーションに接続するための信頼性の高い手段を

提供します。このドライバーはシミュレーション対象のSiemens PLC として機能します。これはSiemens S7-300 のシ

ミュレーション用です。

設定

サポートされているプロトコル
TCP/IP上の産業用イーサネット (ISO 8073 クラス 0)でのS7 メッセージング。これはRFC1006 で定義されています。

サポートされているコマンド
FB14-GET (S7-300)
FB15-PUT (S7-300)
SFB14-GET (S7-400、S7-1500)
SFB15-PUT (S7-400、S7-1500)

チャネルとデバイスの制限値
このドライバーでサポートされているチャネルの最大数は1 です。このデバイスでサポートされている仮想デバイスの最大

数は、1 つのチャネルにつき 256 です。

ライブラリ
このドライバーには標準イーサネットカードが必要です。特別なライブラリやハードウェアは必要ありません。
注記 : このドライバーと通信するためには、デバイスは特別なラダープログラミングを必要とします。

チャネルプロパティ

デバイスのプロパティ

Siemens クライアントデバイスの構成

付録 : SIMATIC Manager を使用した接続の設定

チャネルのプロパティ - 一般

このサーバーでは、複数の通信ドライバーを同時に使用することができます。サーバープロジェクトで使用される各プロトコ

ルおよびドライバーをチャネルと呼びます。サーバープロジェクトは、同じ通信ドライバーまたは一意の通信ドライバーを使

用する多数のチャネルから成ります。チャネルは、OPC リンクの基本的な構成要素として機能します。このグループは、識

別属性や動作モードなどの一般的なチャネルプロパティを指定するときに使用します。
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識別

「名前」 :このチャネルのユーザー定義識別情報を指定します。各サーバープロジェクトで、それぞれのチャネル名が一意

でなければなりません。名前は最大 256 文字ですが、一部のクライアントアプリケーションではOPC サーバーのタグ空間

をブラウズする際の表示ウィンドウが制限されています。チャネル名はOPC ブラウザ情報の一部です。チャネルの作成に

はこのプロパティが必要です。
予約済み文字の詳細については、サーバーのヘルプで「チャネル、デバイス、タグ、およびタググループに適切な名前を

付ける方法」を参照してください。

「説明」 :このチャネルに関するユーザー定義情報を指定します。

「説明」などのこれらのプロパティの多くには、システムタグが関連付けられています。

「ドライバー」 :このチャネル用のプロトコル/ドライバーを指定します。チャネル作成時に選択されたデバイスドライバーを指

定します。チャネルのプロパティではこの設定を変更することはできません。チャネルの作成にはこのプロパティが必要で

す。
注記 :サーバーがオンラインで常時稼働している場合、これらのプロパティをいつでも変更できます。これには、クライア

ントがデータをサーバーに登録できないようにチャネル名を変更することも含まれます。チャネル名を変更する前にクライア

ントがサーバーからアイテムをすでに取得している場合、それらのアイテムは影響を受けません。チャネル名が変更された

後で、クライアントアプリケーションがそのアイテムを解放し、古いチャネル名を使用して再び取得しようとしても、そのアイ

テムは取得されません。大規模なクライアントアプリケーションを開発した場合は、プロパティを変更しないようにしてくださ

い。オペレータがプロパティを変更したりサーバーの機能にアクセスしたりすることを防ぐため、適切なユーザー役割を使用

し、権限を正しく管理する必要があります。

診断

「診断取り込み」 :このオプションが有効な場合、チャネルの診断情報がOPC アプリケーションに取り込まれます。サー

バーの診断機能は最小限のオーバーヘッド処理を必要とするので、必要なときにだけ利用し、必要がないときには無効

にしておくことをお勧めします。デフォルトでは無効になっています。
注記 : ドライバーで診断機能がサポートされていない場合、このプロパティは使用できません。
詳細については、サーバーのヘルプで「通信診断」を参照してください。

診断

「診断取り込み」 :このオプションを有効にすると、チャネルの操作に関するフィードバックをクライアントアプリケーションに提

供する統計タグを使用できます。サーバーの診断機能は最小限のオーバーヘッド処理を必要とするので、必要なときに

だけ利用し、必要がないときには無効にしておくことをお勧めします。デフォルトでは無効になっています。
注記 : ドライバーで診断機能がサポートされていない場合、このプロパティは使用できません。
詳細については、サーバーヘルプの「統計タグ」を参照してください。

タグ数

「静的タグ」 :デバイスレベルまたはチャネルレベルで定義される静的タグの数を指定します。この情報は、トラブルシュー

ティングと負荷分散を行う場合に役立ちます。

チャネルのプロパティ - イーサネット通信

イーサネット通信を使用してデバイスと通信できます。
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イーサネット設定

「ネットワークアダプタ」 :バインドするネットワークアダプタを指定します。空白のままにするか、「デフォルト」を選択した場

合、オペレーティングシステムはデフォルトのアダプタを選択します。

チャネルのプロパティ - 書き込み最適化

サーバーは、クライアントアプリケーションから書き込まれたデータをデバイスに遅延なく届ける必要があります。このため、

サーバーに用意されている最適化プロパティを使用して、特定のニーズを満たしたり、アプリケーションの応答性を高めたり

することができます。

書き込み最適化

「最適化方法」 :基礎となる通信ドライバーに書き込みデータをどのように渡すかを制御します。以下のオプションがありま

す。

l 「すべてのタグのすべての値を書き込み」 :このオプションを選択した場合、サーバーはすべての値をコントローラに

書き込もうとします。このモードでは、サーバーは書き込み要求を絶えず収集し、サーバーの内部書き込みキュー

にこれらの要求を追加します。サーバーは書き込みキューを処理し、デバイスにできるだけ早くデータを書き込む

ことによって、このキューを空にしようとします。このモードでは、クライアントアプリケーションから書き込まれたすべて

のデータがターゲットデバイスに送信されます。ターゲットデバイスで書き込み操作の順序または書き込みアイテム

のコンテンツが一意に表示される必要がある場合、このモードを選択します。

l 「非 Boolean タグの最新の値のみを書き込み」 :デバイスにデータを実際に送信するのに時間がかかっているため

に、同じ値への多数の連続書き込みが書き込みキューに累積することがあります。書き込みキューにすでに置か

れている書き込み値をサーバーが更新した場合、同じ最終出力値に達するまでに必要な書き込み回数ははる

かに少なくなります。このようにして、サーバーのキューに余分な書き込みが累積することがなくなります。ユーザー

がスライドスイッチを動かすのをやめると、ほぼ同時にデバイス内の値が正確な値になります。モード名からもわか

るように、Boolean 値でない値はサーバーの内部書き込みキュー内で更新され、次の機会にデバイスに送信さ

れます。これによってアプリケーションのパフォーマンスが大幅に向上します。

注記 :このオプションを選択した場合、Boolean 値への書き込みは最適化されません。モーメンタリプッシュボタ

ンなどのBoolean 操作で問題が発生することなく、HMIデータの操作を最適化できます。

l 「すべてのタグの最新の値のみを書き込み」 :このオプションを選択した場合、2 つ目の最適化モードの理論がす

べてのタグに適用されます。これはアプリケーションが最新の値だけをデバイスに送信する必要がある場合に特に

役立ちます。このモードでは、現在書き込みキューに入っているタグを送信する前に更新することによって、すべて

の書き込みが最適化されます。これがデフォルトのモードです。

「デューティサイクル」 :読み取り操作に対する書き込み操作の比率を制御するときに使用します。この比率は必ず、読

み取り 1 回につき書き込みが1 から 10 回の間であることが基になっています。デューティサイクルはデフォルトで 10 に設

定されており、1 回の読み取り操作につき 10 回の書き込みが行われます。アプリケーションが多数の連続書き込みを

行っている場合でも、読み取りデータを処理する時間が確実に残っている必要があります。これを設定すると、書き込み

操作が1 回行われるたびに読み取り操作が1 回行われるようになります。実行する書き込み操作がない場合、読み取

りが連続処理されます。これにより、連続書き込みを行うアプリケーションが最適化され、データの送受信フローがよりバラ

ンスのとれたものとなります。
注記 :本番環境で使用する前に、強化された書き込み最適化機能との互換性が維持されるようにアプリケーションの

プロパティを設定することをお勧めします。

チャネルのプロパティ - 詳細

このグループは、チャネルの詳細プロパティを指定するときに使用します。すべてのドライバーがすべてのプロトコルをサポー

トしているわけではないので、サポートしていないデバイスには詳細グループが表示されません。
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「非正規化浮動小数点処理」 :非正規化値は無限、非数 (NaN)、または非正規化数として定義されます。デフォルト

は「ゼロで置換」です。ネイティブの浮動小数点処理が指定されているドライバーはデフォルトで「未修正」になります。

「非正規化浮動小数点処理」では、ドライバーによる非正規化 IEEE-754 浮動小数点データの処理方法を指定でき

ます。オプションの説明は次のとおりです。

l 「ゼロで置換」 :このオプションを選択した場合、ドライバーが非正規化 IEEE-754 浮動小数点値をクライアント

に転送する前にゼロで置き換えることができます。

l 「未修正」 :このオプションを選択した場合、ドライバーは IEEE-754 非正規化、正規化、非数、および無限の

値を変換または変更せずにクライアントに転送できます。

注記 : ドライバーが浮動小数点値をサポートしていない場合や、表示されているオプションだけをサポートする場合、こ

のプロパティは無効になります。チャネルの浮動小数点正規化の設定に従って、リアルタイムのドライバータグ (値や配列

など)が浮動小数点正規化の対象となります。たとえば、EFMデータはこの設定の影響を受けません。

浮動小数点値の詳細については、サーバーのヘルプで「非正規化浮動小数点値を使用する方法」を参照してくださ
い。

「デバイス間遅延」 :通信チャネルが同じチャネルの現在のデバイスからデータを受信した後、次のデバイスに新しい要求

を送信するまで待機する時間を指定します。ゼロ (0)を指定すると遅延は無効になります。

注記 : このプロパティは、一部のドライバー、モデル、および依存する設定では使用できません。

チャネルのプロパティ - 通信プロパティ
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「ポート番号」 : ドライバーが受信待機するポート番号を指定します。このポートに接続するようデバイスを設定する必要

があります。その他のポートに送信されたメッセージはドライバーによって無視されます。有効な範囲は0 から 65535 で

す。デフォルト設定は、TCP/IP: 102 (TSAP)です。
注記 :ルーティングとファイアウォールの問題により、標準以外の値が必要になることがあります。

デバイスのプロパティ - 一般

デバイスは、通信チャネル上の1 つのターゲットを表します。ドライバーが複数のコントローラをサポートしている場合、

ユーザーは各コントローラのデバイス ID を入力する必要があります。

識別

「名前」 :デバイスの名前を指定します。これは最大 256 文字のユーザー定義の論理名であり、複数のチャネルで使用

できます。

注記 :わかりやすい名前にすることを一般的にはお勧めしますが、一部のOPC クライアントアプリケーションではOPC
サーバーのタグ空間をブラウズする際の表示ウィンドウが制限されています。デバイス名とチャネル名はブラウズツリー情報

の一部にもなります。OPC クライアント内では、チャネル名とデバイス名の組み合わせが "<チャネル名>.<デバイス名>"と
して表示されます。
詳細については、サーバーのヘルプで「チャネル、デバイス、タグ、およびタググループに適切な名前を付ける方法」を参

照してください。

「説明」 :このデバイスに関するユーザー定義情報を指定します。

「説明」などのこれらのプロパティの多くには、システムタグが関連付けられています。

「チャネル割り当て」 :このデバイスが現在属しているチャネルのユーザー定義名を指定します。

「ドライバー」 :このデバイスに設定されているプロトコルドライバー。

「モデル」 :この ID に関連付けられているデバイスのタイプを指定します。このドロップダウンメニューの内容は、使用され

ている通信ドライバーのタイプによって異なります。ドライバーによってサポートされていないモデルは無効になります。通信

ドライバーが複数のデバイスモデルをサポートしている場合、デバイスにクライアントアプリケーションが1 つも接続していな

い場合にのみモデル選択を変更できます。
注記 : 通信ドライバーが複数のモデルをサポートしている場合、ユーザーは物理デバイスに合わせてモデルを選択する

必要があります。このドロップダウンメニューにデバイスが表示されない場合、ターゲットデバイスに最も近いモデルを選択

します。一部のドライバーは "オープン"と呼ばれるモデル選択をサポートしており、ユーザーはターゲットデバイスの詳細を

知らなくても通信できます。詳細については、ドライバーに関するマニュアルを参照してください。

「 ID」 :デバイスのドライバー固有のステーションまたはノードを指定します。入力する ID のタイプは、使用されている通信

ドライバーによって異なります。多くの通信ドライバーでは、ID は数値です。数値 ID をサポートするドライバーでは、ユー

ザーは数値を入力でき、そのフォーマットはアプリケーションのニーズまたは選択した通信ドライバーの特性に合わせて変

更できます。フォーマットはデフォルトではドライバーによって設定されます。オプションには「10 進数」、「8 進数」、「16 進

数」があります。
注記 : ドライバーがイーサネットベースであるか、通常とは異なるステーションまたはノード名をサポートしている場合、デ

バイスのTCP/IPアドレスをデバイス ID として使用できます。TCP/IPアドレスはピリオドで区切った4 つの値から成り、各

値の範囲は0 から 255 です。一部のデバイス ID は文字列ベースです。ドライバーによっては、ID フィールドで追加のプロ

パティを設定する必要があります。

動作モード
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「データコレクション」 :このプロパティでは、デバイスのアクティブな状態を制御します。デバイスの通信はデフォルトで有効

になっていますが、このプロパティを使用して物理デバイスを無効にできます。デバイスが無効になっている場合、通信は

試みられません。クライアントから見た場合、そのデータは無効としてマークされ、書き込み操作は許可されません。このプ

ロパティは、このプロパティまたはデバイスのシステムタグを使用していつでも変更できます。

「シミュレーション」 :デバイスをシミュレーションモードに切り替えるかどうかを指定します。このモードでは、ドライバーは物

理デバイスとの通信を試みませんが、サーバーは引き続き有効な OPC データを返します。シミュレーションモードではデ

バイスとの物理的な通信は停止しますが、OPC データは有効なデータとしてOPC クライアントに返されます。シミュレー

ションモードでは、サーバーはすべてのデバイスデータを自己反映的データとして扱います。つまり、シミュレーションモード

のデバイスに書き込まれたデータはすべて再び読み取られ、各 OPC アイテムは個別に処理されます。(サーバーが再初

期化された場合などに)サーバーがアイテムを除去した場合、そのデータは保存されません。デフォルトは「いいえ」です。

注記 :
1. クライアントが切断して再接続するまで、更新は適用されません。

2. システムタグ (_Simulated)は読み取り専用であり、ランタイム保護のため、書き込みは禁止されています。このシステム

タグを使用することで、このプロパティをクライアントからモニターできます。

3. シミュレーションモードでは、アイテムのメモリマップはクライアントの更新レート (OPC クライアントではグループ更新レー

ト、ネイティブおよびDDE インタフェースではスキャン速度)に基づきます。つまり、異なる更新レートで同じアイテムを参

照する 2 つのクライアントは異なるデータを返します。

4. デバイスをシミュレートしたときに、クライアントで更新が1 秒未満で表示されない場合があります。

シミュレーションモードはテストとシミュレーションのみを目的としています。本番環境では決して使用しないでください。

タグ数

「静的タグ」 :デバイスレベルまたはチャネルレベルで定義される静的タグの数を指定します。この情報は、トラブルシュー

ティングと負荷分散を行う場合に役立ちます。

デバイスのプロパティ - スキャンモード

「スキャンモード」では、デバイスとの通信を必要とする、サブスクリプション済みクライアントが要求したタグのスキャン速度

を指定します。同期および非同期デバイスの読み取りと書き込みは可能なかぎりただちに処理され、「スキャンモード」の

プロパティの影響を受けません。

「スキャンモード」 :購読しているクライアントに送信される更新についてデバイス内のタグをどのようにスキャンするかを指定

します。オプションの説明は次のとおりです。
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l 「クライアント固有のスキャン速度を適用」 :このモードでは、クライアントによって要求されたスキャン速度を使用し

ます。
l 「指定したスキャン速度以下でデータを要求」 :このモードでは、最大スキャン速度として設定されている値を指

定します。有効な範囲は10 から 99999990 ミリ秒です。デフォルトは1000 ミリ秒です。

注記 :サーバーにアクティブなクライアントがあり、デバイスのアイテム数とスキャン速度の値が増加している場

合、変更はただちに有効になります。スキャン速度の値が減少している場合、すべてのクライアントアプリケーショ

ンが切断されるまで変更は有効になりません。

l 「すべてのデータを指定したスキャン速度で要求」 :このモードでは、指定した速度で購読済みクライアント用にタ

グがスキャンされます。有効な範囲は10 から 99999990 ミリ秒です。デフォルトは1000 ミリ秒です。

l 「スキャンしない、要求ポールのみ」 :このモードでは、デバイスに属するタグは定期的にポーリングされず、アクティ

ブになった後はアイテムの初期値の読み取りは実行されません。更新のポーリングは、_DemandPoll タグに書き

込むか、個々のアイテムについて明示的なデバイス読み取りを実行することによって、OPC クライアントが行いま

す。詳細については、サーバーのヘルプで「デバイス要求ポール」を参照してください。

l 「タグに指定のスキャン速度を適用」 :このモードでは、静的構成のタグプロパティで指定されている速度で静的タ

グがスキャンされます。動的タグはクライアントが指定したスキャン速度でスキャンされます。

「キャッシュからの初期更新」 :このオプションを有効にした場合、サーバーは保存 (キャッシュ) されているデータから、新た

にアクティブ化されたタグ参照の初回更新を行います。キャッシュからの更新は、新しいアイテム参照が同じアドレス、ス

キャン速度、データ型、クライアントアクセス、スケール設定のプロパティを共有している場合にのみ実行できます。1 つ目

のクライアント参照についてのみ、初期更新にデバイス読み取りが使用されます。デフォルトでは無効になっており、クライ

アントがタグ参照をアクティブ化したときにはいつでも、サーバーがデバイスから初期値の読み取りを試みます。

デバイスのプロパティ - CPU 設定

「ラック番号」 :このプロパティでは、シミュレーション対象となる目的のCPU が格納されているラックの番号を指定します。

有効な範囲は0 から 7 です。各デバイスのラックとスロットの値が一意である必要があります。デフォルトの設定は0 で

す。

「CPU スロット」 :このプロパティでは、シミュレーション対象となる目的のCPU が格納されているスロットの番号を指定し

ます。有効な範囲は0 から 31 です。各デバイスのラックとスロットの値が一意である必要があります。デフォルトの設定は

0 です。
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「最大 PDU サイズ」 :このプロパティでは、ドライバーがサポートするプロトコルデータユニットの最大サイズを指定します。

有効な値は、240、480、および 960 バイトです。

注記 :デバイスでネゴシエートされている PDU 値を監視するには、_CurrentPDUSize 内部タグを使用してください (内
部タグを参照)。

Siemens クライアントデバイスの構成

読み書きコマンドをドライバーに発行し、返されたデータを処理するよう、Siemens PLC がプログラミングされている必要

があります。詳細については、Siemens PLC プログラミングのドキュメントを参照してください。Siemens クライアントのデ

バイスと非送信請求ドライバーを通信用に準備する方法については、SIMATIC Managerを使用した接続の設定を参

照してください。

非送信請求ドライバーが動作しているホストコンピュータの選択したイーサネットアダプタの IPアドレスにメッセージが送

信される必要があります。このためには、チャネルのプロパティを更新します。
シミュレーション対象のデバイスに設定されているポート番号の詳細については、通信プロパティ を参照してください。

内部タグ

次の内部タグはサーバー構成に表示されませんが、OPC クライアントによるブラウズは可能です。これらは<チャネル名
>.<デバイス名>._InternalTagsグループで見つかります。OPC クライアントでブラウズがサポートされていないか、非 OPC
クライアントが使用されている場合、以下に示すアドレスを使用してタグを動的または静的に作成できます。

デバイスアドレス 説明 範囲
デー

タ型

ア

ク

セ

ス

_
CurrentPDUSize

接続の後は、このタグは、デバイスとネゴシエートされたプロトコルデータユ

ニットのサイズを示します。接続する前は、最大構成のPDU 値を示しま

す。

240,
480,
960

Word 読

み

取

り
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データ型の説明

データ型 説明

Boolean 1 ビット

Byte 符号なし 8 ビット値

Char 符号付き 8 ビット値

Word 符号なし 16 ビット値

ビット 0 が下位ビット

ビット 15 が上位ビット

Short 符号付き 16 ビット値

ビット 0 が下位ビット

ビット 14 が上位ビット

ビット 15 が符号ビット

DWord 符号なし 32 ビット値

ビット 0 が下位ビット

ビット 31 が上位ビット

Long 符号付き 32 ビット値

ビット 0 が下位ビット

ビット 30 が上位ビット

ビット 31 が符号ビット

BCD 2 バイトパックされたBCD

値の範囲は0-9999 です。この範囲外の値には動作が定義されていません。

LBCD 4 バイトパックされたBCD

値の範囲は0-99999999 です。この範囲外の値には動作が定義されていません。

Float 32 ビット浮動小数点値。

ドライバーは2 つ目のレジスタを上位 Word、1 つ目のレジスタを下位 Word とすることで、連続す

る 2 つのレジスタを浮動小数点値として解釈します。

String Null 終端 ASCII文字列
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アドレスの説明

次の情報は、S7-300 とS7-400 の両方のモデルに適用されます。動的に定義されるタグのデフォルトのデータ型を太字

で示しています。

アドレスタイプ 範囲 データ型 アクセス

離散入力 I0.b-I4095.b*
.b は0-7 のビット番号

IB0-IB4095

IW0-IW4094

IW:KT0-IW:KT4094

IW:KC0-IW:KC4094

ID0-ID4092

Boolean

Byte、Char、String**

Word、Short、BCD

DWord、Long

Word、Short

DWord、Long、LBCD、Float

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

離散入力

注記 : IとEは同じメモリ

領域にアクセスします。

E0.b-E4095.b*
.b は0-7 のビット番号

EB0-EB4095**

EW0-EW4094

EW:KT0-EW:KT4094

EW:KC0-EW:KC4094

ED0-ED4092

Boolean

Byte、Char、String**

Word、Short、BCD

DWord、Long

Word、Short

DWord、Long、LBCD、Float

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

離散出力 Q0.b-Q4095.b*
.b は0-7 のビット番号

QB0-QB4095

QW0-QW4094

QW:KT0-QW:KT4094

QW:KC0-QW:KC4094

QD0-QD4092

Boolean

Byte、Char、String**

Word、Short、BCD

DWord、Long

Word、Short

DWord、Long、LBCD、Float

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

離散出力 A0.b- A4095.b*
.b は0-7 のビット番号

Boolean 読み取り/書き

込み
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アドレスタイプ 範囲 データ型 アクセス

注記 : QとAは同じメモリ

領域にアクセスします。

AB0-AB4095

AW0-AW4094

AW:KT0-AW:KT4094

AW:KC0-AW:KC4094

AD0-AD4092

Byte、Char、String**

Word、Short、BCD

DWord、Long

Word、Short

DWord、Long、LBCD、Float

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

内部メモリ F0.b-F4095.b*
.b は0-7 のビット番号

FB0-FB4095

FW0-FW4094

FW:KT0-FW:KT4094

FW:KC0-FW:KC4094

FD0-FD4092

Boolean

Byte、Char、String**

Word、Short、BCD

DWord、Long

Word、Short

DWord、Long、LBCD、Float

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

内部メモリ

注記 : FとMは同じメモリ

領域にアクセスします。

M0.b-M4095.b*
.b は0-7 のビット番号

MB0-MB4095

MW0-MW4094

MW:KT0-MW:KT4094

MW:KC0-MW:KC4094

MD0- MD4092

Boolean

Byte、Char、String**

Word、Short、BCD

DWord、Long

Word、Short

DWord、Long、LBCD、Float

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

Boolean データブロック DB1-N:KM0.b-KM4094.b*
1-N はブロック番号

.b は0-15 のビット番号

または

DB1DBX0.b-DBNDBX4094.b*
1-N はブロック番号

.b は0-15 のビット番号

Boolean

Boolean

読み取り/書き

込み

読み取り/書き

込み
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アドレスタイプ 範囲 データ型 アクセス

DB1D0.b-DBND4094.b*
1-N はブロック番号

.b は0-15 のビット番号

Boolean

読み取り/書き

込み

左側 Byte データブロック DB1-N:KL0-KL4095
1-N はブロック番号

または

DB1DBB0-DBNDBB4095
1-N はブロック番号

DB1DL0-DBNDL4095
1-N はブロック番号

Byte、Char、String**

Byte、Char、String**

Byte、Char、String**

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

右側 Byte データブロック DB1-N:KR0-KR4094
1-N はブロック番号

または

DB1DR0-DBNDR4094
1-N はブロック番号

Byte、Char、String**

Byte、Char、String**

読み取り/書き

込み

読み取り/書き

込み

データブロック符号なし

Word
DB1-N:KH0-KH4094
1-N はブロック番号

Word、Short、BCD 読み取り/書き

込み

データブロック符号付き

Word
DB1-N:KF0-KF4094
1-N はブロック番号

または

DB1DBW0-DBNDBW4094
1-N はブロック番号

DB1DW0-DBNDW4094
1-N はブロック番号

Word、Short、BCD

Word、Short、BCD

Word、Short、BCD

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

符号付き Long 型データブ

ロック

DB1-N:KD0-KD4092
1-N はブロック番号

または

DB1DBD0-DB1DBD4092
1-N はブロック番号

DB1DD0-DB1DD4092
1-N はブロック番号

DWord、Long、LBCD、Float

DWord、Long、LBCD、Float

DWord、Long、LBCD、Float

読み取り/書き

込み

読み取り/書き

込み

読み取り/書き

込み

データブロック Float DB1-N:KG0-KG4092
1-N はブロック番号

Float 読み取り/書き

込み

データブロックBCD DB1-N:BCD0-BCD4094
1-N はブロック番号

Word、Short 読み取り/書き

込み

データブロックDB としての

S5 タイマー

DB1-N:KT0-KT4094
1-N はブロック番号

DWord、Long 読み取り/書き

込み

データブロックDB としての

S5 カウンタ

DB1-N:KC0-KC4094
1-N はブロック番号

Word、Short 読み取り/書き

込み
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アドレスタイプ 範囲 データ型 アクセス

データブロックString DB1:S0.n-DB1:S4095.n*
.n は文字列長です。

0<n<=932。

String 読み取り/書き

込み

*これらのメモリタイプ/サブタイプでは配列がサポートされていません。
**Byte 型のメモリ (MB)では文字列がサポートされます。文字列の構文は<アドレス>.<長さ>であり、ここで 0 <長さ <=
932 です。

注記 :

1. I、Q、Fタイプのメモリのオフセットはすべて、そのタイプのメモリ内でのバイト開始位置を表します。

2. Word、Short、DWord、Long 型を修正する場合には注意が必要です。I、Q、Fの場合、デバイス内で各アドレ

スは1 バイトずつオフセットして開始しています。このため、Word FW0 とFW1 はByte 1 で重複します。FW0 に

書き込むと、FW1 に保存されている値が修正されます。同様に、DWord 型とLong 型でも重複することがありま

す。これらのメモリタイプは重複が生じないように使用することをお勧めします。たとえば、DWord 型を使用してい

る場合にバイトの重複を回避するには、FD0、FD4、FD8 などを使用します。

3. 文字列では、要求されたバイトの合計数は、ネゴシエートされている PDU サイズのデータの部分を超えることが

できません。生文字列がネゴシエートされている PDU サイズを超えている場合、読み取りまたは書き込みに失

敗する可能性があります。

配列
(上記以外の)すべてのメモリタイプ/サブタイプで配列がサポートされています。配列の宣言に有効な構文については以下

で説明します。行数が指定されていない場合、行数は1 であると見なされます。

<アドレス>[行数 ][列数 ]
<アドレス>.行数 .列数
<アドレス>,行数 ,列数
<アドレス>_行数_列数

Word、Short、BCD、および "KT"配列の場合、ベースアドレス + (行数 * 列数 * 2)が4096 を超えることはできません。

配列の要素はWord 型であり、Word 型境界上にあります。たとえば、IW0[4]では IW0、IW2、IW4、および IW6 が返さ

れます。"KT"サブタイプのデータはWord 型に格納されてPLC に保存されるため、"KT"サブタイプは16 ビットカテゴリに

分類されます。

Float、DWord、Long、および Long BCD 配列 ("KT"サブタイプを除く)の場合、ベースアドレス + (行数 * 列数 * 4)が
4096 を超えることはできません。この配列の要素はDWord 型境界上にある DWord 型であることに注意してください。

たとえば、ID0[4]では ID0、ID4、ID8、および ID12 が返されます。

すべての配列では、要求されているバイトの合計数は、ネゴシエートされている PDU サイズのデータの部分を超えること

ができません。たとえば、960 バイト PDU サイズが指定されている場合、読み取りまたは書き込みが可能な単一の配列

は最大 932 バイトです。

KL とKR とDBB
KL とKR は、Word 型データブロックの左側バイトと右側バイトのどちらが返されるかを指定します。

値 8 9 A B C

Byte 0 1 2 3 4

例 1
DB1:KH0=0x89
DB1:KL0=0x8
DB1:KR0=0x9
DB1DBB0=0x8

例 2
DB1:KH1=0x9A
DB1:KL1=0x9
DB1:KR1=0xA
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DB1DBB1=0x9

例

l 内部メモリF20 のビット 3 にアクセスするには、アドレスを F20.3 として宣言します。

l データブロック 5 のバイト 30 にWord メモリとしてアクセスするには、アドレスを DB5:KH30 として宣言します。

l データブロック 2 のバイト 20、ビット 7 にアクセスするには、アドレスを DB2:KM20.7 として宣言します。

l データブロック 1 のバイト 10 に左側 Byte メモリとしてアクセスするには、アドレスを DB1:KH10 として宣言します。

l 内部メモリF20 にDWORD としてアクセスするには、アドレスを FD20 として宣言します。

l 入力メモリ I10 にWord としてアクセスするには、アドレスを IW10 として宣言します。
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イベントログメッセージ

次の情報は、メインユーザーインタフェースの「イベントログ」 枠に記録されたメッセージに関するものです。「イベントログ」

詳細ビューのフィルタリングとソートについては、OPC サーバーのヘルプを参照してください。サーバーのヘルプには共通メッ

セージが多数含まれているので、これらも参照してください。通常は、可能な場合、メッセージのタイプ (情報、警告) とト
ラブルシューティングに関する情報が提供されています。

非送信請求通信を開始できませんでした。|ポート番号 = <数値>。
エラータイプ:
エラー

考えられる原因 :

1. ドライバーは非送信請求通信のリッスンソケットを作成できませんでした。指定されたポートは別のアプリケーショ

ンによって使用されている可能性があります。

2. システムリソースが不足している可能性があります。

解決策 :

1. ネットワークモニターソフトウェアを使用して、別のアプリケーションがそのポートを使用しているかどうかを調べてくだ

さい。別のアプリケーションが使用している場合、競合するアプリケーションをシャットダウンしてOPC サーバーを

再起動してください。競合するアプリケーションが空きポートを自由に選択可能な場合、必ずサーバーを最初に

起動することで必要なポートを要求できるようにします。PLC プログラミングソフトウェアとこのドライバーの両方が

同じポートを使用する必要がある場合、同時に使用できない可能性があります。

2. 十分なシステムリソースがあることを確認し、ほかのプロセスからリソースを解放してください。

関連項目 :
チャネル設定
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Appendix: Configuring Connections Using the
SIMATIC Manager
Connections are configured using the SIMATIC Manager software. The following topics provide information on
configuring the Siemens TCP/IP Server Ethernet ドライバー to run in unsolicited mode, and demonstrate a basic
setup using the S7-300 PLC as the active partner and the driver as the passive partner.

Note: The Siemens TCP/IP Server Ethernet ドライバーcan configure 256 devices, each with an associated
slot/rack. When the active partner (Siemens client) communicates with the passive partner (unsolicited or
Siemens server driver), it directs its requests to a specific device in the unsolicited driver. Multiple remote
partners can talk to the same device.

To jump to a specific section, select a link from the list below.

Step One: Creating a New Project
Step Two: Configuring the Siemens Client and PC Station
Step Three: Connecting the Siemens Client and the Siemens Server Driver
Step Four: Inserting Function Blocks
Step Five: Creating the DB3 Data Block
Step Six: Inserting PUT FB
Step Seven: Downloading to the PLC

Step One: Creating a New Project

1. To start, open the SIMATIC Manager software and then create a new project. In this example, the project
being used is "Setup".
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2. Create the Siemens client and PC Station. To do so, right-click in the right pane of the window and then
select Insert New Object | SIMATIC 300 Station.

Tip: The Siemens client unit is the active partner or the image of the actual PC. The PC Station is the
PC on which the SIMATIC Manager software is running.

3. Name the new station "SIEMENS-CLIENT" because it represents the communication's active partner.
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4. Right-click in the right pane of the window and select Insert New Object | SIMATIC PC Station.

 For more information, refer to Step Two: Configuring the Siemens Client and PC Station.

Step Two: Configuring the Siemens Client and PC Station
Industrial Ethernet (IE) is the protocol used for communication.

1. To start, right-click in the right pane of the SIMATIC Manager window. Select Insert New Object |
Industrial Ethernet.
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2. Select the SIEMENS CLIENT icon in the left pane of the window and double-click Hardware.

www.ptc.com

21



Siemens TCP/IP Server Ethernet ドライバー

3. Open the View tab and select Catalog.

4. Expand the SIMATIC 300 menu and the Rack 300 menu.
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5. To insert the racks, double-click on Rail.

6. Expand the PS 300 menu. Double-click on PS 307 10A or any other suitable option to insert the power
supply into slot 1.
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7. To insert the CPU, expand both the CPU 300 menu and the CPU 315-2 DP menu.
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8. Double-click on the CPU that matches the hardware.
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9. To insert the CPU into slot 2, click OK.

10. To insert the CP, leave slot 3 empty and then click on slot 4 in the racks.

11. Expand both the CP 300 menu and the Industrial Ethernet menu.

12. Double-click on the CP that matches the hardware.
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13. Enter the PLC's IP address and subnet mask. Select Ethernet from the subnet box.
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14. Click OK to configure the Siemens client.

15. Once finished, open the View tab and select Catalog to hide the catalog window.

16. Save and exit the HWConfiguration window.

17. To configure the PC station, click on the SIMATIC PC Station in the left pane of the SIMATIC Manager
window.

18. Double-click on Configuration.
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19. Click on the View tab and select Catalog.

20. Expand both the SIMATIC PC Station menu and the CP Industrial Ethernet menu.

21. Double-click on General or any other suitable option.
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22. Enter the IP address of the PC running the SIMATIC Manager software, in addition to the correct subnet
mask.

23. Select Ethernet from the subnet box.
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24. Click OK to configure the PC station.

25. Once finished, open the View tab and select Catalog to hide the catalog window.

26. Save and exit the HWConfiguration window.

For more information, refer to Step Three: Connecting the Client and the Server Driver.

Step Three: Connecting the Siemens Client and the Siemens Server Driver
Once the Siemens client and the PC Station have been successfully configured, the Siemens client and the
Siemens server must be connected.

1. To start, open the Options tab in the SIMATIC Manager window and select Configure Network.
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2. Click on the Siemens client's CPU 315-2 DP block. A series of rows should be displayed in the lower
half of the window.

www.ptc.com

34



SiemensTCP/IPServer Ethernetドライバー

3. Right-click on the first row and select Insert New Connection.

4. Click OK.
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5. Enter the IP address of the machine on which the Siemens TCP/IP Server Ethernet ドライバー runs.

6. Click Address Details and enter the rack/slot values of the device in the unsolicited driver with which the
Siemens client should communicate.

7. Click OK twice to successfully connect the Siemens client and server drivers. The Siemens client uses
these settings to communicate with the destination device at rack 0 and slot 2.
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Note: The Local ID number (=1) identifies the connection between the two partners. This number is
used later when creating function blocks for reading and writing data.

8. Save and compile the data by opening the Network tab and selecting Save and Compile. Click OK.

Note: There should be no errors on compilation.

For more information, refer to Step Four: Inserting Function Blocks.

Step Four: Inserting Function Blocks
Once the Siemens client has been configured and connected with the Siemens server or unsolicited driver, it
must also be prepared to generate requests for the unsolicited partner. This is done by creating function blocks,
which can be used to read data from or write data to an unsolicited driver. The function block (FB) used for
reading data in this example is FB14 (GET). The function block (FB) for writing data is FB15 (PUT).
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1. Expand the Siemens client menu, the CPU 315-2 DP menu, and the S7 Program[1] menu.

2. Double-click on Blocks and OB1.

3. LAD, STL, or FBD can be used to create function blocks. In this example, FBD is used. In the
LAD/STL/FBD window, click on the Insert menu.
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4. Click Program Elements.

5. Expand the Libraries, SIMATIC_NET_CP, and CP 300 menus.
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6. Double-click on FB14 GET to insert a function block to read data.
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7. Close the Program Elements window. "FB14" should be inserted as shown below.

8. Associate a data block (DB) with the function block (FB). To do so, click above the FB where there are
three red question marks.
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9. Enter the name of a data block. In this example, it is "DB2".

10. Click Yes to create the data block.

11. Fill in the other details as appropriate for the fields in the function block. Users should consider the
following:

l "ADDR_1" is the address on the destination device in the unsolicited driver.

l "RD_1" is the address local to the PLC.

l The value at the remote address specified by "ADDR_1" is written (GET) to the local address
specified by "RD_1".

l Enter the Local ID number that was generated when setting up the connection between the
Siemens client and the Siemens server driver in the ID field. In this example, the Local ID
number is 1.
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The number of bytes in both the "ADDR_1" and "RD_1" fields should be same for the
unsolicited driver to respond correctly. Otherwise, an error occurs.

Note: Now that the GET function block has been created successfully, users must remember that the
block gets executed / triggered only on a rising edge (REQ).

12. Click Save and close the LAD/STL/FBD window.

For more information, refer to Step Five: Creating the DB3 Data Block.

Step Five: Creating the DB3 Data Block
While configuring GET FB, the data block "DB3" was used for the "RD_1" field. This is the data block that stores
read values.

1. Right-click in the right pane of the SIMATIC Manager window and then select Insert New Object| Data
Block.
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2. Change the name to "DB3."
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3. Double-click on DB3. To assign some memory to the data block, users can make changes similar to
those shown below. Although the array size in this example is arbitrary, values should be specified to fit
a particular need.

4. Save and close the LAD/STL/FBD window.

For more information, refer to Step Six: Inserting PUT FB.

Step Six: Inserting PUT FB

1. Create a separate data block for the PUT FB, which holds the data that is written to the remote partner.
To insert this new data block, follow the steps in Step Five: Creating the DB3 Data Block but name it
"DB5."

2. Double-click on DB5, then specify a memory size. Although the array size in this example was chosen
arbitrarily, the values should be specified to fit a particular need.
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3. To insert the PUT FB, double-click on OB1 in the SIMATIC Manager window.

4. In LAD/STL/FBD, right-click in the blank space below GET FB.
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5. Click Insert Network and select the blank space below.

6. Click Insert | Program Elements.

7. Expand the Libraries, SIMATIC_NET_CP, and CP 300 menus.

8. To insert a function block to write data, double-click on FB15 PUT.
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9. Close the Program Elements window.

10. Associate a data block (DB) with the function block (FB). To do so, click above the FB where there are
three red question marks.

11. Specify a name. In this example, "DB4" is used.

12. A window prompt requests confirmation of data block creation. Click Yes.

13. Fill in the other details as appropriate. Users should consider the following:

l "ADDR_1" address is on the destination device in the unsolicited driver.

l "SD_1" is the address local to the PLC.

l The value at the local address specified by "SD_1" is written (PUT) to the remote address
specified by "ADDR_1".

l Enter the Local ID number that was generated when setting up the connection between the
Siemens client and the Siemens server driver in the ID field. In this example, the Local ID
number is 1.

Important: The number of bytes in both the "ADDR_1" and "SD_1" fields should be same for
the unsolicited driver to respond correctly. Otherwise, an error occurs.
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14. Click Save and close LAD/STL/FBD.

For more information, refer to Step Seven: Downloading to the PLC.

Step Seven: Downloading to the PLC
Once the Siemens client has been prepared to generate Read / Write requests for the remote unsolicited
partner, the information must be downloaded to the PLC.
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1. Click Siemens client in the left pane of the SIMATIC Manager window.

2. Select the PLC menu.

3. Select Download to begin downloading the project to the PLC.

4. Click OK.

5. Click Yes.

Note: The Siemens client must be run to trigger the function blocks that generate Read / Write
requests.
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6. Double-click on OB1 in the SIMATIC Manager window.

7. In LAD/STL/FBD, click Debug | Monitor.

Note: LAD/STL/FBD should appear in Online Mode.
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8. To execute GET/PUT FBs, change the REQ value to 0 and then 1 to indicate the rising edge. To do so,
right-click on the REQ field and select Modify to 0 to force a zero to the field.
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9. Right-click on the REQ field and select Modify to 1 to force a value of one to the field.
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Note: Both of the FBs must next be configured to respond to the same rising edge for the SIMATIC
Manager's variables to be locally monitored and modified.

10. In LAD/STL/FBD, click on PLC and select Monitor/Modify Variables.

11. Enter the variables to be monitored. To view the changes made to this window, execute the function
blocks.
Note: Remember that the slot / rack value of the remote device with which the Siemens client is

communicating is "rack:0 slot:2". The values can be changed from the NetPro window. Users must make
sure that the Siemens server or unsolicited driver on the other end has a device with these values and is
running.
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